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Lab 7 - Complete the Design of a USB Receiver  
 
A note to those outside of Purdue who choose to make use of the information in this 
laboratory exercise. It is part of a series of exercises in which students practice writing 
synthesizable RTL level VHDL code, culminating in the creation of standard cell IC 
layout using SOC Encounter. However, those exercises include the use of non-Cadence 
tools. It is also based on a standard cell library developed originally at the Illinois 
Institute of Technology by Prof. James Stine who is now at Oklahoma State University.  
The design flow described in this exercise should be readily adaptable to any design for 
which you have a synthesized verilog netlist of your design, a LEF file, and 
corresponding transistor level views for Virtuoso. This exercise was written for use with 
SOC Encounter version 4.1. 
 
In this lab, you will: 
 

• Generate Several Layouts (Physical Designs) of the USB Receiver using SOC 
Encounter. 

• Utilizing timing analysis capabilities of SOC Encounter to analyze your USB 
Receiver design. 

 
 
1. Copying Setup Files 
 
Download and extract Lab7.tar for sample input files used in this exercise. The text 
below will make several references to file found here.  
 
 
2. General Comments Regarding Lab 7 
 
The purpose of this lab is to provide the student with exposure to layouts, physical 
designs that are constructed for designs based upon STANDARD CELLS. Throughout 
this course, you have been applying a standard cell design approach to your lab 
assignments and your projects. The VHDL source code that you write is mapped, via 
synthesis software, to a standard cell library based netlist. This library is comprised of 
cells that have previously been laid out in such a fashion that all the cells have the same 
height. This allows tools known as ‘Place and Route’ tools to take a design in a Hardware 
Description Language, such as VHDL or Verilog, and create a Layout for that design 
without the designer having to layout the individual cells or connect the cells together to 
generate the design. At this point, some of you may be thinking: “This sounds like the 
perfect way to design chips. Why do companies, such as AMD, Hewlett-Packard, IBM, 
Intel, and SUN not employ this scheme to design their respective microprocessors?” This 
is such a good question, that it deserves a place on the Lab 7 Check-Off sheet. 
 
QUESTION: Why do you think that companies do not employ a fully Standard Cell, 
Place and Route approach to the high performance portions of their microprocessor 
designs? (Actually, these companies do use the approach for less critical portions of 
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their microprocessor designs.)  
 
 
The reason that you are concerned about layout in this course is due to the fact that layout 
is the actual representation of what a design will look like in silicon. The familiar 
symbols for NAND and NOR gates are ideal for working in the schematic arena; 
however, you would find it difficult to locate a NAND gate in an actual layout if you 
were looking for the schematic symbol. In actuality, gates in silicon are constructed from 
the interaction of various layers in the final design. Therefore, fabricated devices are not 
simply 2-dimensional constructions. They are in fact 3-dimensional. During the 
fabrication process for a chip, it is built in stages. Each stage utilizes a different “mask”. 
 
This “mask” is essentially a glass plate that is transparent in certain areas and opaque in 
others. The “mask” defines where certain layers are allowed to be located in the 
fabricated design. Thus after one layer has finished its “masking” stage, the next “mask” 
layer is begun. However, the different layers are actually insulated from each other by 
materials similar to Silicon Dioxide, the “oxide” in Metal Oxide Semiconductor. If the 
layers are insulated from each other, how does one connect them if they need to be 
connected? This connection is accomplished by elements known as “vias” or “contacts”. 
In most cases, “vias” refer to connections for metal interconnect layers and “contacts” 
refer to connections between active/diffusion and metal to form the source/drain 
connections on a transistor. 
 
Also, it should be noted that the layouts you will be producing in this lab will contain 
Input/Output (I/O) pads. When a chip is completely fabricated, I/O pads are necessary in 
order to solder wires to the chip. These wires are then connected to the actual pins on the 
package. The pins on the package are what your chip uses to interface to the outside 
world. I/O pads serve several functions. The main function that is of importance to this 
class is that I/O pads act as buffers to drive signals into and out from the chip. 
 
At this point you may be wondering: “So, if our layouts do not have I/O Pads, what good 
are they?” To answer this question, one can think about large microprocessor designs. In 
these designs, not every block interfaces to the outside world, so it is advantageous to 
have a program that can produce a layout for an internal block that simply has pins, but 
no I/O pads. These pins provide a means by which other blocks can connect to the inputs 
and outputs of the current block. In addition, I/O pads are typically much larger than the 
cells that are used to create the block; therefore, if every block in a design required I/O 
pads, the area of the overall design would grow quite rapidly. Designs with a larger area 
than necessary are not cost-efficient. In actuality this type of automated layout, layout 
having pins but no I/O pads, is done quite often in microprocessor design for blocks that 
are not timing critical, blocks that will not affect the performance of the design. This is 
done in an effort to shorten the design cycle as manual layout is much more time-
consuming than having a tool do the layout for you. 
 
 
3. Synthesizing USB Receiver Design with I/O pads 
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This part of the exercise involves the use of synthesis scripts that cannot be made 
available. However, the purpose of this section was to instruct students to use synthesis 
software to produce a mapped verilog netlist based on the target cell library used in 
ECE337.  
 

 
 
4. First Pass Layout of USB Receiver 
 
Once you have synthesized your design, you are now ready to generate the layout for 
your USB Receiver. The setup script should have copied files needed for this to your Lab 
7 directory.  One of the files that was copied was the encounter.tcl script. This is the 
script that automates the generation of the layout. Examine this script with your favorite 
text editor and see how the layout process flows. The commands needed to produce the 
layout are explained by the comments in the .tcl script. Also examine the configuration 
file encounter.conf that is utilized by the script to define your design name, path, etc.  
 
As mentioned before, the layout you are going to generate is going to include I/O pads. 
As you might have read from the configuration file, you have to match the pad name in 
your synthesized verilog code (inside your mapped directory with the .v extension) with 
the pad names defined inside the encounter.io file. So open the verilog file, look for the 
USB_RCVR module and find the I/O pad definitions (the keyword for VDD is 
PADVDD, GND IS PADGND, output pads is PADOUT and PADINC is for input pads). 
Be advised that your verilog file may contain multiple modules, but you need to look for 
the module declaration of your top level. This usually is the last module in the file. Now, 
examine the encounter.io file that was copied by the setup script, it should look similar 
to:  
 
# This file specifies how the pads are placed 
# The name of each pad here has to match the 
# name in the verilog code 
# The Mosis padframe has 4 corners and 40 pads 
 
Version: 2 
 
Pad: U1 W 
Pad: U9 W 
Pad: U18 W 
Pad: U19 W 
Pad: U2 W 
Pad: U20 W 
Pad: U21 W 
Pad: U6 W 
Pad: U7 E 
Pad: U8 E 
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Pad: U10 E 
Pad: U11 E 
Pad: U12 E 
Pad: U13 E 
Pad: U14 E 
Pad: U15 E 
Pad: U16 E 
Pad: U17 E 
 
The format of the pad declaration in the .io file is: 
 
Pad:  PadName Direction  
 
So for example, Pad: U9 W means that pad U9 will be located in the western border of 
the chip. Direction can be N, S, W, E, NW, etc. (North, South, West, East, Northwest, 
etc.). So the above encounter.io file will define pad locations for the following verilog 
description where all the input pads are located in the western border of the chip, and 
some output pads are in the eastern border and some in the western border: 
 
module  USB_RCVR ( CLK, RST, D_PLUS, D_MINUS, R_ENABLE, FULL, EMPTY, 
R_ERROR, RCVING,  
        R_DATA ); 
 
input   CLK, RST, D_PLUS, D_MINUS, R_ENABLE; 
output  [7:0] R_DATA; 
output  FULL, EMPTY, R_ERROR, RCVING; 
wire    n3, n6, n9, n4, n10, n2, n11, n8, n1, n5, n0, n7; 
 
USB_RCVR_t I0 ( .CLK(CLK), .RST(RST), .D_PLUS(D_PLUS), 
.D_MINUS(D_MINUS), .R_ENABLE(R_ENABLE), .FULL(n8), .EMPTY(n9), 
.R_ERROR(n10), .RCVING(n11), .R_DATA(R_DATA) ); 
 
PADVDD U1 (  ); 
PADGND U2 (  ); 
PADOUT U3 ( .DO(n9), .YPAD(EMPTY) ); 
PADOUT U4 ( .DO(n8), .YPAD(FULL) ); 
PADOUT U5 ( .DO(n11), .YPAD(RCVING) ); 
PADOUT U6 ( .DO(n7), .YPAD(R_DATA[0]) ); 
PADOUT U7 ( .DO(n6), .YPAD(R_DATA[1]) ); 
PADOUT U8 ( .DO(n5), .YPAD(R_DATA[2]) ); 
PADOUT U9 ( .DO(n4), .YPAD(R_DATA[3]) ); 
PADOUT U10 ( .DO(n3), .YPAD(R_DATA[4]) ); 
PADOUT U11 ( .DO(n2), .YPAD(R_DATA[5]) ); 
PADOUT U12 ( .DO(n1), .YPAD(R_DATA[6]) ); 
PADOUT U13 ( .DO(n0), .YPAD(R_DATA[7]) ); 
PADOUT U14 ( .DO(n10), .YPAD(R_ERROR) ); 
PADINC U15 ( .DI(CLK), .YPAD(CLK) ); 
PADINC U16 ( .DI(D_MINUS), .YPAD(D_MINUS) ); 
PADINC U17 ( .DI(D_PLUS), .YPAD(D_PLUS) ); 
PADINC U18 ( .DI(RST), .YPAD(RST) ); 
PADINC U19 ( .DI(R_ENABLE), .YPAD(R_ENABLE) ); 
endmodule 
 
You have some freedom on where you want to locate the I/O pads, but in a real world 
design, some considerations that must be made include signal delay and noise. You don’t 
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want to put sensitive I/O pads of your chip close to a noise source (such as power and 
ground). Also, you don’t want your I/O pads to be far away from the chip block that is 
using/producing them because that adds delay to the signal. For your design however, it 
is recommended for you to group the related inputs/outputs together. Keep in mind that 
the number of pads you have on one side of the chip can alter your chip’s aspect ratio 
(what is this? See next section). So if you want to create a square chip, distributing the 
number of pads evenly between sides really helps. Another trick to help SOC Encounter 
to route better is to place the GND pad in between two other pads (see example above). 
 
You will also need to make your chip layout such that it includes filler pads and corner 
pads. Without them it may result in power and ground not being distributed inside your 
chip and I/O pads. The I/O pads also need power because there are buffers inside the I/O 
pads. 
 
To include the filler pads, you will need to declare “dummy” pads in your encounter.io 
file. The format for adding a dummy pad is: 
 
Pad: <Name> <Direction> PADNC 
 
For example:  
 
Pad: U102 N PADNC 
 
declares a dummy pad called U102 that is located on the northern border of your chip. 
Note: The pad name is arbitrary, but there better not be anything else called U102 in the 
Verilog file (for example, grep on U102 in the .v file if in doubt). The syntax for 
declaring a corner pad is: 
 
Orient: R<degree> 
Pad: <Name> <Corner direction> PADFC 
 
For example: 
 
Orient: R270 
Pad: c02 NE PADFC 
 
declares a corner pad called c02  in the North East corner of your chip with an orientation 
of 270 degrees. 
 
The entire chip must be “padded”. This is what the filler pads are used for. MOSIS allows 
us a maximum of 40 I/O pads. The USB design uses significantly less than 40 I/O pads 
(19 to be precise), so filler pads will occupy the rest of the padding around the chip. 
Modify your encounter.io file so each side of your chip has 10 pads (dummy or not) and 
has all four corner pads (note: for a core bound design you might need to insert even 
more filler cells. For the final project, if you use the full 3mm x 3mm allowable area, you 
will need more than 10 I/O pads or fillers on each side). The following encounter.io file is 
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an example of a completed encounter.io file that will generate a layout with filler pads 
and corner pads for the design shown earlier: 
 
# This file specifies how the pads are placed 
# The name of each pad here has to match the 
# name in the verilog code 
# The Mosis padframe has 4 corners and 40 pads 
 
Version: 2 
 
Orient: R0  
Pad: c01 NW PADFC 
Orient: R270 
Pad: c02 NE PADFC 
Orient: R180 
Pad: c03 SE PADFC 
Orient: R90 
Pad: c04 SW PADFC 
 
Pad: U102 N PADNC 
Pad: U103 N PADNC 
Pad: U104 N PADNC 
Pad: U105 N PADNC 
Pad: U106 N PADNC 
Pad: U107 N PADNC 
Pad: U108 N PADNC 
Pad: U109 N PADNC 
Pad: U110 N PADNC 
Pad: U111 N PADNC 
 
Pad: U112 S PADNC 
Pad: U113 S PADNC 
Pad: U114 S PADNC 
Pad: U115 S PADNC 
Pad: U116 S PADNC 
Pad: U117 S PADNC 
Pad: U118 S PADNC 
Pad: U119 S PADNC 
Pad: U120 S PADNC 
Pad: U121 S PADNC 
 
Pad: U1 W 
Pad: U3 W  
Pad: U9 W 
Pad: U18 W 
Pad: U19 W 
Pad: U2 W 
Pad: U4 W 
Pad: U5 W 
Pad: U6 W 
Pad: U101 W PADNC 
 
Pad: U7 E 
Pad: U8 E 
Pad: U10 E 
Pad: U11 E 
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Pad: U12 E 
Pad: U13 E 
Pad: U14 E 
Pad: U15 E 
Pad: U16 E 
Pad: U17 E 
 
Now after you have done the needed modifications, issue the command: 
 
grid encounter  
 
in your terminal to invoke SOC Encounter. In your Encounter command line, issue the 
following command to run the .tcl script: 
 
encounter 1> source encounter.tcl 
 
A successful run should produce a layout that is displayed in the encounter user interface. 
Try to zoom in and out if the user interface is not focused in your layout. Once you have 
the ‘layout’ view of your USB_RCVR on screen, have a TA check off your work up to 
this point. 
 

 
 
Now you need to run a connectivity check on your design. From the SOC Encounter User 
interface, select: 
 
Verify > Verify Connectivity 
 
This will create a new pop up menu. In the Verify connectivity menu, select “All” for Net 
Type and Nets. For this lab, you are asked to do the connectivity check on open 
connections, unconnected pin, connectivity loop, antenna and geometry loop. Click OK. 
Examine the report generated by the connectivity check and make sure there are no 
violations or error. If you encounter any violations or errors, you can fix them by 
modifying your layout generation floorplan parameters such as aspect ratio and row 
density and generating a new layout. 
 
Once you have an errors and violations free connectivity check, have a TA check off 
your work up to this point. 
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Layout in SOC Encounter 

 
5. Setting Up Cadence for Layout 
 
The layout you are viewing in Encounter only shows the interconnects. In order to show 
the transistors in your layout, you need to use a new tool, Cadence.  In order to begin 
using Composer, you will need to bring up Cadence's Command Interface Window 
(CIW). In order to invoke the CIW, type the following command at your UNIX prompt, 
make sure that you are in your ~/ece337/Lab7 directory before issuing this 
command: 
 
grid icfb 
 
The CIW will appear at the bottom of your screen, and will look like Figure 1 below. 
 

 
 

Figure 1: CIW Window 
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Now you need to create your library by selecting the following Menu option from the 
CIW window: 
 
File > New > Library... 
 
This will bring up a window that will look like Figure 2. 
 

 
 

Figure 2: Create Library Window 
 

Fill in the following values: 
 
Name: My_Layout 
Path: ~/ece337/ 
Technology Library: Compile tech library  AMI 0.60u C5N 
I/O Pad Type: Perimeter 
 
Click OK.  
 
Next you will need to import the layout stream file that was generated by SOC encounter 
to Cadence Virtuoso. To do this, from the CIW window menu, select: 
 
File > Import > Stream... 
 
This will bring up a window that will look like Figure 3. 
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Figure 3: Stream In Window 

 
A template for this window has been provided for you. Just browse and find the file 
icfb.template in your Lab7 directory and click Load. The values should be automatically 
filled in. Click OK. Once the process is done, a pop up box will notify you about how 
many errors or warning you may have. If you receive some errors, display the log file and 
seek what your error is. Notify your TA about your error. If you received warnings, then 
display the log file and make sure the warnings are non destructive (warning about date 
format is not destructive). 
 
Once you have completed the layout and import process you can open up the layout by 
selecting the following Menu option from the CIW window: 
 
Tools > Library Manager... 
 
This will bring up a window that will look like Figure 4. 
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Figure 4: Library Browser Window 
 
You can now select the library in which the layout was placed.  From here you should be 
able to select your USB_RCVR design inside the My_Layout library and finally double-
click on the “layout”. This should open up your layout which should be similar to Figure 
5. 
 

 
Figure 5: I2C Transmitter Layout 
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Now, you will need to swap the “blank” cellview in your current layout with the real 
standard cell layout. First, you need to change your display option so the layout editor 
will display all the layers. To do this, in your Virtuoso Layout Editor window click: 
 
Options > Display... 
 
or you may use the hotkey “e”. Now it will open a new window for display options. 
Change the display levels stop to 20. You may save this new setting by clicking the 
“Save To” button in the bottom of the window to save this to your .cdsenv file. Click OK. 
 
Now, you need to swap the cellviews. Again, in the Virtuoso Layout Editor select: 
 
Edit > Search... 
 
or you may use the hotkey “S”. This will bring up the search window. You want to search 
for “inst” in “current cellView”. Now you want to add two criteria to your search by 
clicking the “Add Criteria” button twice. The criteria are: “lib name = = My_Layout” and 
“view name = = layout”. Now at the bottom of the search window, there is a replace drop 
box. You want to replace your blank cellview with the standard cellview from the 
IIT_stdcells_ami05 library. To do this, select “lib name” from the replace drop box and 
type IIT_stdcells_ami05 in the box next to it. Click Apply. You might have to wait while 
Virtuoso is searching for the cellviews. When the “Current Figure” and “Figure Count” 
numbers in your search window changes from 0, then you know that it is done searching. 
The next step is to replace the cellviews by clicking the “Replace All” button. You should 
be able to see your complete chip, including the I/O pads, in your layout editor, similar to 
Figure 6. 
 
Notice that in the process of opening the ‘layout’ view of the “USB_RCVR”, a new 
window, titled “LSW” also opened. “LSW” stands for Layer Selection Window. Examine 
this window and you will see that it is partially a legend of the different layers in the 
layout of your USB. Essentially, it is showing you what layer each color or colored 
pattern in the layout view corresponds to. Utilizing the “LSW” answer the following 
question: 
 
QUESTION: What colors in the Layout correspond to Metal1 and Poly1? 
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Figure 6: Complete I2C Transmitter Layout 

 
 
Now, examine the window that contains the ‘layout’ view for your USB. Are you able to 
distinguish any NAND or NOR gates? How about D Flip-Flops? In fact, when examining 
layouts of designs even as small as ~200 gates, it is difficult to distinguish individual 
transistors. Examine the layout more closely by zooming into any region of the layout. In 
order to zoom in, select the following option: 
 
Window > Zoom > In 
 
Next, Click the LMB on a location in the layout, then move the mouse to create a 
rectangle, when you feel like you will zoom in on an area of interest click the LMB 
again. Notice how you have zoomed in on the design. Can you identify an individual 
transistor? Zoom in until you can identify an individual transistor. If you are having 
trouble identifying a transistor, please ask a TA for assistance. 
 
Now, zoom back out until you can see the entire design. In order to see the entire 
design again, select the following option: 
 
Window > Fit All 
 
Now you need to save your layout by selecting in the layout editor: 
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Design > Save (hotkey is f2) 
 
Now, move the mouse cursor around and look at the upper left corner of the window. 
Notice how the values next to the X and the Y are changing as you move the mouse 
across the design. Theses are the coordinates at which the mouse is currently located. The 
origin of these coordinates is located at the intersection of the two bright white lines that 
are in the layout view. 
 
Now utilizing your newly found abilities, PRECISELY, to 2 decimal places, 
determine the X and Y coordinates of the LOWER LEFT CORNER of the 
BLUE/TEAL BOX around your layout of the USB Receiver. RECORD this value on 
your Check-off Sheet. Now do the exact same procedure to determine the X and Y 
coordinates of the UPPER RIGHT Corner. In addition, it should be noted that the 
units of the X and Y coordinates are micrometers (um). 
 
Once you have the coordinates for BOTH the LOWER LEFT and the UPPER RIGHT 
corner of the box, have a TA check your values and sign-off your check-off sheet. 
 

 
 
QUESTION: What is your USB’s area for this layout? 
 
 
6. Alter the Aspect Ratio of the Layout 
 
In this exercise you will alter the Aspect Ratio of your USB to see what impact it has on 
your layout. Modify your encounter.tcl so that SOC Encounter will produce a layout 
with aspect ratio of 2. To find out how, open the SOC Encounter help file from the 
Encounter User Interface by clicking Help. This will bring up the user manual for SOC 
Encounter in your web browser. Basically you will need to supply the right argument to 
the floorplan command in your script. Therefore, in the manual, look at how the 
argument of floorplan is supposed to be supplied. A quick reference for this can be found 
by clicking on the “Related Documents” link on the Encounter main help page and 
clicking again on the “Encounter Text Command Reference” link. Look under “Floorplan 
Commands” for the command “floorplan”. From here you can figure out what parameters 
you need to change for the floorplan command in your .tcl script. (Hint: the current 
aspect ratio of your chip is 1.0) 
 
After you are done modifying your .tcl script, run the script to generate a new layout. 
Once a new layout has been produced, examine it and have a TA check off your work 
up to this point. 
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QUESTION: How does altering the Aspect Ratio of a design affect the design’s 
Layout? In essence, what mathematical formula could you derive for the Aspect Ratio?  
 
 
7. Row Density/Utilization Investigation 
 
The final layout parameter that is going to be investigated is that of Row 
Density/Utilization. The first step in our investigation of the Row Density parameter is to 
produce a layout of the USB that has a Row Density equal to 40% and aspect ratio 
of 1. (hint: examine the syntax of the floorplan command in encounter) 
 
Follow the same procedure that you did in previous sections to bring up your modified 
USB Layout. Once you have the ‘layout’ view of your USB on screen, have a TA check 
off your work up to this point. 
 

 
 
Obtain the coordinates of the LOWER LEFT and UPPER RIGHT corners of the 
DASHED PURPLE BOX that encompasses the layout of your USB. (You can obtain 
the coordinates of the corners from Encounter. No need to import it to icfb) 
 
 
Once you have the coordinates for BOTH the LOWER LEFT and the UPPER RIGHT 
corner of the box, have a TA check your values and sign-off your check-off sheet. 
 

 
 
QUESTION: What is your USB’s area for this layout? 
 
QUESTION: How does this new area compare with the area that was previously 
calculated for the layout of the USB utilizing only default values? Does this make sense 
given the two values for Row Utilization? 
 
Finally, do you think you can produce a layout of the USB that has a Row Utilization 
equal to 100%? 
 
QUESTION: Do you think you should be able to generate a layout for the USB when 
the Row utilization is set to 100%? If so, do it and briefly describe how the layout looks, 
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its similarities, and its differences to the previous layouts generated. Also, does it have 
many design rule violations (marked with an “X” in your layout and can you see how 
many from the log in the command line)?  If you think you should not be able to generate 
a layout, briefly explain why? 
 
 
8.  Timing Analysis 
 
To run the timing analysis, you will need to specify the timing constraints. SOC 
Encounter takes timing constraints in the format of Synosys PrimeTime. Luckily a 
template has been provided for you. Copy the template to your Lab 7 directory from the 
following location: 
 
/home/ecegrid/a/ece337/Class0.5u/Lab7/USB_RCVR.pt 
 
Examine the format. You may open the SOC Encounter help file if you need more 
information on the format of the file. The pin names in the file should already match your 
design’s pin names. From the Encounter user interface, select: 
 
Timing > Load Timing Constraint … 
 
Specify “USB_RCVR.pt” as the timing constraint file and click OK. Now select: 
 
Timing > Timing Analysis … 
 
This will bring up another window as shown in Figure 7. Set the settings appropriately 
for your design and click OK. You may want to examine the Slack report file (.slk 
extension) and the Detailed Violation File (.tarpt extension) to see if your design violates 
the timing constraints.  
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Figure 7: Timing Analysis 

 
 
You can view each timing analysis path by selecting: 
 
Timing > Timing Debug > Slack Browser … 
 
Select USB_RCVR.slk as your input file. 
 
This will allow you to select a path by double clicking on the path and the selected path 
will be highlighted in your layout. It will also display the complete path. Another useful 
feature in the Slack Browser shows the path in schematic mode if you select the ”Show 
Path Schematic” checkbox. 
 
Using the Slack Browser, write down in your checkoff sheet the starting and ending 
components of your critical path and the number of combinational logic blocks in 
between. (Hint: you may want to utilize the schematic feature of the slack browser for 
this). 
 
What block does your critical path start from? What block does it end at? 
 
At this point, students are normally instructed to examine the synthesis report files 
generated earlier to compare timing analysis results.  
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Once you written down the answers to the questions above, have a TA check off 
your work up to this point. 

 
 
 
Now, we want to investigate the maximum clock speed of your USB design. Most likely 
with the default timing constraint file (with a clock period of 100 ns), you will have 
enough slack in your critical path.  
 
We want you to modify the timing constraint file so that the clock period is reduced 
enough to produce a negative slack for your critical path. 
 
To do this, change the clock period in the timing constraint file. The command in your 
timing constraint file should be self-explanatory. One thing you need to know is that you 
will need to modify your clock waveform so it will create a clock with a 50% duty cycle. 
You will need to change the rising and falling time in the waveform tuple. 
 
Run the timing analysis again with the new constraints and write down what clock period 
you have determined in your checkoff sheet. Have a TA check off your work up to this 
point. 
 

 


